
MM:GIF Multimedia GIF Player

MM:GIF is a multimedia GIF file viewer. It can play multi-image GIF files that include both MIDI music 
and Wave PCM sound data.
The Graphics Interchange Format is the Copyright property of CompuServe Incorporated. GIF(sm) is 
a Service Mark property of CompuServe Incorporated.
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System Requirements
MM:GIF is a Windows 3.1 program and will run on any machine that satisfactorily runs Windows. But 
realistically, any graphics program is both memory and CPU-speed intensive. For optimal satisfaction 
you should probably have a 486 with 4 meg of ram, an SVGA monitor capable of 640x480 resolution at 
256 colors, and some sort of MIDI device, such as a sound card. A 386 works fine but displays the 
images more slowly. A machine with 2 meg of ram may not have enough memory to decode the larger 
gifs. A lower resolution monitor with fewer colors will make you wonder why you bother. Nearly all 
mmgifs contain 256 color images. It simply isn't possible to reduce 256 colors to 16 without serious 
compromise. To hear the music encoded in an mmgif, you have to have a MIDI device. In fact, to play an
mmgif at all, you have to have a MIDI device. (But see No Sound Card for a way around this limitation).

For more information about ways to cope with systems that have less than optimal configurations, see 
Frequently Asked Questions.



What's New

This version of MM:GIF includes support for the new transition effects that are available to creators of 
MM:GIFs with the new EMBED.EXE tool. These effects allow the GIF image to be displayed in an 
evolving pattern, rather than all at once. Due to the speed differences between computers with various 
processors and video cards, a new Image Transitions Option has been added to the Options menu. 
Slower computers may not display the transitions fast enough for the file to be viewed the way its creator
intended, and faster computers may minimize the transition effects. Slower computers may also not 
show images that were meant to be shown because they would have been showing during the time 
taken up by the transition effect of the previous image.

A new Play List option has been added to the File menu. this option allows you to create and play 
groups of MM:GIFs.



MIDI Configure

The MIDI Configure dialog box allows the selection of Windows 3.1 MIDI output drivers. Several output 
ports may be configured, but most GIF contained MIDI files will specify only one output port. In order to 
select or change a driver, simply highlight the driver of interest and click on the Add button.    To remove 
a driver, highlight the driver and press Delete.
If you have an FM sound card, you will usually get better results by selecting the sound card's FM driver 
directly (instead of the MIDI Mapper). 

See also MIDI Configure Dialog



Driver Configure

The Driver Configure dialog box allows adjustment of the perceived polyphony capabilities of the 
currently selected MIDI driver. Some internal sound card drivers may report an actual number of voices 
that the driver can support, but external MIDI interfaces have no way of telling what MIDI modules are 
attached to the other end of the cable. By adjusting the number of voices in the polyphony box, you can 
aid MM:GIF in deciding which rendition of a MIDI file to play.

If the warning box is checked, MM:GIF displays a warning when the requirements of a MIDI file exceed 
the stated polyphony capacity.

The choose rendition with radio buttons tells MM:GIF how to pick a rendition:

Best Match Chooses a rendition that the driver can play 
without losing notes

Maximum Polyphony Chooses the rendition that contains the 
most voices

Maximum Polyphony Chooses the rendition that contains the 
least voices

See also Driver Configure Dialog



File
Open
Opens a .gif file. See Open File Dialog
Close
Closes current file without exiting MM:GIF.
Play List
Opens a dialog box to select a previously saved Play List. See Play List
Details
Provides information about each of the images in the Gif file as well as any comments about the file the 
author may have inserted.
File List
Provides a list of the last four files opened by MM:GIF. Selecting one of these names will open that file.
Exit
Duh.



Run
Play
If the file opened is a Multimedia Gif and Auto Play is not selected, Selecting Play will start playback. If 
Auto Play is selected (See Options) or if the file is a single Gif image, then playback begins immediately
when the file is opened.
Stop
Selecting this will stop playback of a Multimedia Gif.
Continue
Continues playback that was Stopped.



View
First
Next
Current
Previous
Last
When playback is stopped, selecting one of these items will show either the First, Next, Current, 
Previous, or Last image in the file, without playing the associated MIDI file. Note that the order of the 
images in the file is not necessarily the same order as you viewed them.
Blank
Substitutes a blank image for the image currently displayed.



Play List

MM:GIF offers a Play List feature: a collection of multimedia GIFs which can be performed in sequence.
In order to create or use Play Lists, select the File/Play List... menu item.

Creating a Play List
A new Play List is created by adding files to the dialog list box.    When the list box is first opened, only 
the ---End List--- line is displayed.    To add files, press the Insert button or press the Insert key on the 
keyboard.    A File Open dialog is presented.    Multiple files may be selected at one time from the File 
Open dialog, by clicking and dragging or by using the Shift and Ctrl keys in conjunction with the mouse. 
After pressing OK, any files selected are inserted in the Play List box.    You can control where files are 
inserted by high-lighting a line in the Play List box before pressing Insert: any files added are inserted 
before the high-lighted line.
Files may be deleted from the Play List by selecting a file and pressing the Delete key or button.    By 
combining Insert with Delete, the list can be completely reordered.

Opening and Saving Play Lists
An existing Play List is opened via the Load Button.    A File Open dialog is presented which displays all 
files with the .MGL extension in the last directory accessed.
A Play List is saved by pressing the Save button on the Play List dialog.    If the list already has a name, 
it is suggested in the File Save dialog, but a list may be saved with any name.    A .MGL extension is 
added if not supplied.

Using Play Lists
In order to use a Play List, the Use check box must be set.    Once it is set, and the OK button is 
pressed, the current file in the list (the one which is high-lighted) is read into memory and readied for 
Play.    If the Auto-play menu option is checked, (see Options) playback begins immediately, otherwise 
the program waits for a play begin instruction.    In either case, the remainder of the list is processed 
without further user interaction required.    If you look at the File menu, you will notice that the Play 
List... option has a check-mark by it.    If the Options/Loop menu switch is set, the entire list will repeat 
again from the beginning.    In this case playback will only end when you explicitly end it.

See also Play List Dialog



Playing Files
As soon as MM:GIF is configured for a MIDI device, you can begin to play multimedia GIF files with it. 
Files can be opened by choosing File/Open... or by dragging a file from the File Manager into an open 
copy of MM:GIF.

If the GIF file contains MIDI tracks it will wait for you to start playback by choosing Run/Play. You can 
also configure MM:GIF to automatically begin playback as soon as the file is opened and processed: 
see Options.

See also Load and Run Files



Options

You can adjust certain playback parameters by selecting options from the Option menu. A check mark 
beside an option means that it is in effect:

Option Result
Auto Dither This only has effect for 16 color VGA drivers. If you 

have one of these, enabling this option will allow an
approximation of the 256 color images -- usually 
better than the Windows default. 

Auto Play Will begin playback as soon as a GIF file loads.
Auto Loop Will continually playback the same GIF over and 

over. If you choose this option and Full Screen 
you'll have a Multimedia Screen Saver.

Center Image Causes all Images to be centered on the screen.
Full Screen Checking this option causes the Image to occupy 

the entire screen, the next time it is displayed (by 
choosing View/Current, for instance).    The image 
is not re-sized however. The mouse cursor will 
disappear, but any keystroke or a left mouse click 
will restore the screen. The cursor reappears after 
playback ends.

Screen Background Allows choice of a different screen background 
color.

Image Transitions Adjusts the speed of the effects to match the speed
of your computer. On a slower computer, choose 
Fast or Faster to ensure that the effect is finished in
time for the next image.

Product Support

MM:GIF was envisioned and created by CompuServe Staff in the Sight And Sound Forum.
Consequently, it will be supported within the Sight And Sound Forum on CIS:    GO SSFORUM

Credits and Acknowledgment
Chief Wizop Visionary: Jim Maki -Sysop [76701,33]
Design and Implementation: Jamie O'Connell -Sysop [72662,1433]
MIDILIB.DLL Library: Dan McKee -Sysop [71333,1572]
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MM:GIF Help File: Jerry Jorgenrud [75060,1040]
EMBED.EXE - GIF Embedder: Tom LeCompte -Sysop [76711,572]

A special thanks to the Sight & Sound Studio Workshop Group



Disclaimer
This program is provided without any warranty, expressed or implied, including but not limited to fitness 
for a particular purpose.



Tutorial
This tutorial is designed to take the first-time user through the process of setting up MM:GIF to view files
and run the viewer. Use the Browse buttons (<<    >>) on the menu to step through sequentially, or click 
on the area below to advance to.
Configuration
Optional Settings
Load and View Files



MIDI Configure Dialog
After running the setup program and starting MM:GIF by clicking its icon in Program Manager, you need 
to configure the program for your machine and equipment. MM:GIF will search for installed sound card 
drivers the first time it runs. If it does not find any drivers, it will select the MIDI Mapper as its output 
device. You should check to see that the MIDI device you want to use has been selected.

From the Options menu, select MIDI Configure.

Put the mouse cursor over parts of the dialog box you would like more information about, or TAB to the 
area with your keyboard.

For more information see MIDI Configure



Driver Configure Dialog
Sound card drivers can report the capabilities of the sound card. You would only want to change the 
number of voices (maximum polyphony) reported if you were using a MIDI interface card connected to 
external equipment. In this case, the driver does not know the capabilities of the equipment and you can 
supply it. This information is not strictly necessary, but helps MM:GIF decide how best to play a song 
with a large number of voices.

Put the mouse cursor over parts of the dialog box you would like more information about, or TAB to the 
area with your keyboard.

For more information see Driver Configuration



Wave Configure Dialog

You can choose whether or not to decompress in memory wave files that may be in the Gif, and which 
quality of wave file to force MM:GIF to use.

Put the mouse cursor over parts of the dialog box you would like more information about, or TAB to the 
area with your keyboard.



Load and Run Files

Select File and Open from the menu and get a standard File Open dialog. The only files you can choose
are files with a .gif extension. You can load standard Gif files or MMGif files.

Put the mouse cursor over parts of the dialog box you would like more information about, or TAB to the 
area with your keyboard.

Select Run and Play to view the selected file.

See also Playing Files



Optional Settings
From the Options Menu you can control certain aspects of MM:GIFs behavior. 

Select Auto Play if you want the Gifs to begin playing as soon as they are loaded.

Select Auto Loop if you want the Gifs to continuously repeat.

Select Auto Dither if you run a 16 color video driver. Most Gifs are 256 colors, and selecting Auto Dither
will give you the best approximation.

Select Center Image if you want the Gifs to automatically center themselves in the screen. Note that 
MM:GIFs can contain location information that will override this setting.

Select Full Screen if you want the Gifs to display maximized.

Select Screen Background to change the background color that shows behind a Gif that does not 
cover the entire screen.

Select Image Transitions to adjust the speed of the effects in the newer MM:GIFs. How quickly the Gifs
display depends on your CPU speed, your video speed, your video resolution, and the number of colors 
you are using. You may have to choose Fast, Faster, or None if you have a non-accelerated video card 
and a CPU slower than a 486.

For more information see Options



Output Port
This is the port that MM:GIF will send the MIDI information to. If no port is selected, then no music will be
heard.



Available Output Ports
This is a list of drivers you have installed on your machine that report that they are MIDI devices. If there
are no devices in this list, you will not be able to play MM:GIF files.



Add Button
After choosing an output port from the list of available drivers, use this button to add them to the Output 
Port list.



Delete Button
After selecting a driver in the Output Port list, use this button to remove it from that list. This means it will
no longer be your output driver. Note that this does not mean the driver is deleted from your hard disk. It
will still appear in your Available Output Ports list.



Input Port
This function is not used by MM:GIF and would normally be set to <none>.



Driver
This is the name of the MIDI driver you have selected in the MIDI Configure Dialog.



Driver Capabilities
This shows the number of simultaneous voices that the driver reports as its capability. Change this 
number if you have external MIDI equipment and you know its capability. You can un-check the 
Warnings box if you do not want MM:GIF to tell you every time a MIDI file in a Gif requires more voices 
than the driver can produce.



Choose Rendition
This helps MM:GIF decide how to play a song that reports it requires more simultaneous voices than is 
listed in the Capabilities box



Decompress in memory
Check this box to have MM:GIF decompress any embedded wave files in available memory, which gives
better performance. Un-check this box if you have many programs running at once or do not have much 
memory.



Force Width
You can force MM:GIF to decode all wave files to 8-bit if you only have an 8-bit sound card.



File List
Type in the name of the .gif file or select it from the list.



Directory
Select the directory you want to search for .gif files



List
The only choice is .gif files



Drives
Choose the drive to search for .gif files



Use
This box must be checked to run the files in the Play List



Insert
Using this button causes a standard file selection dialog to appear. Choose the file, or files, you want to 
add to the play list. Choose multiple files using the Shift or Ctrl keys as you would in File Manager.



Delete
Select a file in the Play List and use this button to remove it from the list.



Load
Choosing this button causes a standard file dialog to appear. You can search for Play List files you have 
saved with the .mgl extension.



Save
Use this button to save the Play List you have created. The file will have an .mgl extension.



List Box
This box shows the files in the Play List.



Play List Dialog

Put the mouse cursor over parts of the dialog box you would like more information about, or TAB to the 
area with your keyboard.



MIDI Mapper
The MIDI Mapper is a driver provided with Windows. Using it can be confusing, so Dan McKee prepared
a FAQ file (MMQUST.TXT) which can be found on the Sight and Sound and the MIDI Forums. Portions 
of that file relative to MM:GIF have been extracted and placed here for your convenience. Seek out the 
full file if these portions do not answer your questions.

Q.    What's the MIDI Mapper for anyway?
Q.    Okay, how does it provide this independence?
Q.    Huh?    What's a patch, channel and velocity?
Q.    Will it work with all MIDI files?
Q.    What's General MIDI?
Q.    What are the differences between Microsoft's way and the real General MIDI Specification?
Q.    What are the capabilities of a Basic device?
Q.    Okay, what about Extended devices?
Q.    Where do I install the Sound Drivers?
Q.    What's this setting called MIDI?
Q.    What are the MIDI Mapper Setups?
Q.    When would I have to edit or create a MIDI Mapper Setup?



A.    The MIDI Mapper's purpose is to provide device independence to MIDI devices.    It attempts to do 
that same thing that the printer drivers do, for instance - a Windows program doesn't have to know how 
to deal with your specific printer type, it just deals with a generic printer.    Then Windows and the printer 
driver figure out how to make the printed output appear.



A.    Technically, what the MIDI Mapper does, is remap patches, notes, channels and adjust velocities.    It
uses the Patch Map, Key Map and Setup to determine how to do this.    You can create or adjust these 
yourself.



A.    These are all part of the MIDI lingo.    A Patch is used to determine the sound to be used - examples 
would be Pianos, Strings or Guitars.    Patches are used to select which instrument is used.    Channels 
are used to separate songs to allow more than one instrument to sound at the same time.    There are 16
MIDI channels, and each channel can use a single instrument or patch at a time.    All notes are played 
on a MIDI channel. Velocity is a measure of how hard a note is pressed, and is used to specify how loud
a particular note is.



A.    Well, kinda yes and no.    Until recently, there wasn't any standard for patch numbers, or note 
numbers.    It was up to the manufacturer to determine what patch number to use for a Piano sound for 
instance.    Now there is a General MIDI specification, which does identify which instrument is to be used
for each patch number.    However, there are a large number of songs out there that are not General 
MIDI.    Now this doesn't mean that you shouldn't try to play non-General MIDI files with the MIDI 
Mapper.    The worst that can happen is it'll sound bad.



A.    This is an official specification from the International MIDI Association (the MIDI standards 
committee).    Microsoft has used a subset of the specification for their own purposes.    Microsoft has 
adopted the General MIDI patch numbers and drum key numbers, however they have not taken the 
complete specification.



A.    The General MIDI Specification requires much more capable MIDI equipment than Microsoft.    A real
General MIDI device supports 32 note polyphony (that's 32 notes sounding at the same time), and uses 
all 16 MIDI channels.    This is more than Microsoft's target device can handle, so Microsoft has defined 
two less capable devices - a "Basic" device, and an "Extended" one.    They've also defined a set of 
"Authoring Guidelines" for MIDI files.



A.    A Basic device must be capable of playing 6 melodic notes, in at least three different instruments, as
well as 5 percussion notes.    All sound cards are capable of this - in fact, most can only do this.    Basic 
devices are supposed to listen to MIDI channels 13 through 15 for the melodic instruments, with the 
drums on channel 16.    The Adlib, Sound Blaster and original Sound Blaster Pro are all Basic devices, 
as are most sound cards.



A.    Extended devices must be capable of 16 melodic notes, using 9 instruments, plus 16 note, 8 
instrument percussive.    Extended devices are supposed to listen to MIDI channels 1 through 9 for 
melodic sounds, with the drum track on channel 10.    Examples of Extended devices include the Roland 
MT-32/LAPC, Roland Sound Canvas series (including the SCC-1), and Turtle Beach's MultiSound card.



A.    All sound drivers are installed using the Window Control Panel application (in your Main program 
group).    Once started, Control Panel shows a set of icons - choose the one labeled Drivers to install, 
remove or configure sound drivers.    Now a list of the currently installed drivers will be shown - press 
Add to add a new driver.    Most sound cards come with drivers for them - follow the manufacturer's 
directions to install the drivers. This is also fairly well documented in your Windows manuals.



A.    Most sound cards include an optional MIDI connection.    Often this is an add on.    You'd use this to 
connect an external MIDI device, such as a keyboard.    Unless you've got an external MIDI device, you 
can ignore anything like "Sound Blaster 1.0 MIDI" - if you use this, you won't hear anything.



A.    A Setup in the MIDI Mapper connects a key map and patch map to a set of drivers.    A Key map is 
used to remap drum notes, and the patch map is used to remap patches.    The setup ties all of these 
together, and assigns a patch map, key map and device to each MIDI channel.



A.    If you've got a MIDI device that isn't supported in the list of available setups, you'll have to edit the 
setup.    For instance, someone with a Roland Sound Canvas is probably using the Windows MPU-401 
driver.    The Sound Canvas is a real General MIDI device - it doesn't need any patch or key maps.    You 
can easily create a setup for this - just assign "MPU-401"        as the driver for each channel, and save 
the setup.



MM:GIF Frequently Asked Questions

Hey! No Sound!!!
What's With The Warnings?!!!
The Images Stink!!!
I Get "Out Of Memory" Errors!!!
What If I Don't Have A Sound Card?



Q.    I just downloaded the mmgif.zip package from the CompuServe SSForum and the audio 
doesn't work. I have a Pro Audio Spectrum 16 sound card (or Sound Blaster or XYZ Brand Sound
Card) and it does play midi files through the Windows Media Player just fine?

A.    Most sound cards come with new setups for the MIDI Mapper. There are often three setups that will 
use the internal sounds of the sound card -- one labeled "Basic", one labeled "Extended" and one 
labeled "All". The differences between these three setups are the channels used. A Basic setup will 
ignore anything on channels 1 to 12, and an extended setup will ignore anything on channels 11 
through 16. The All setup will listen to all 16 MIDI channels. 
You can also bypass the MIDI Mapper altogether and select your FM driver directly by using the 
Options/MIDI Configure . . . menu item.

Q.    When do I use All?

A.    For songs contained in multimedia GIFs, All is the best setting. MIDI songs contained in GIF's 
adhere to the General MIDI Standard (not Microsoft authoring guidelines -- see MIDI Mapper).    This 
means that they contain MIDI data on any of the 16 channels, with percussion on channel 10.



Q.    I get a warning message saying that the "Song (Song Name) sends output on channels not 
supported by my driver"?

A.    If you are using the MIDI Mapper as the output device, see the No Sound suggestions about using 
the ALL MIDI Mapper setting. If you are using the Jamie O'Connell - FM Synth driver directly, open the 
Control Panel applet and select (put an X in) all 16 channels, select the "save settings" box, press the 
Apply button, and then press the Close button.

Q.    I get a warning message saying that the "Song (Song Name) requires more voices (number) 
than my driver supplies (number)..."?

A. This is simply an advisory message. MM:GIF will play the song and adjust itself according to the 
choice you made in the Driver Configure Dialog Box. You will frequently get this message when using a 
sound card driver supplied by most manufacturers. Most stock FM drivers cannot play more than 6 
notes at once. If you have a more advanced card with 2 OPL2 FM chips or a single OPL3 or OPL4 FM 
chip (Sound Blaster Pro, SB16, Media Vision PAS 16, etc.), and want to hear more notes, download the 
FM Synth driver (FMSYN.ZIP). This driver has the ability to play 15 notes at once.



Q.    I tried to use your mm-gif viewer on another .gif file that displays very nicely on cshow.exe 
(or other DOS viewer) and find that your mm:gif returns an image that is overlayed with white-
dots. What Gives?

A.    In order to achieve the highest resolution, MM-GIF requires that a Super-VGA card is installed, and 
that a 256 color driver is installed in Windows. DOS programs can set VGA cards into other video modes
-- Windows programs must use the video driver that is currently installed. The "white-dots" or cross-
hatching are dithering marks. They are produced when MM-GIF translates a 256 color picture into 16 
colors. Trust me, it is better looking than if we didn't do the conversion!
GIF files cannot contain more than 256 colors so you may get more memory available, and better 
response if you switch to a 256 color driver from a more capable one (16 million colors?).



Q.    I Downloaded your mmgif viewer, and was disappointed to find it would not work. It will view 
a GIF file, poorly, but when I try to load the smallest file on the forum (teapot) it sends an "OUT 
OF MEMORY" message. I do not have one of the mega-memory monsters, I simply have 2 megs 
RAM?

A.    Its time to upgrade! GIF files are compressed. Some GIFs can compress much more than others. 
When expanded, Teapot occupies over 2 Megs of RAM -- it is definitely not the smallest, although it's 
disk image is. A realistic minimum amount of memory for playing multimedia GIFs is about 4 Megs of 
RAM. All files currently available will play in 4 Megs on a properly configured PC.

Q.    What do you mean "properly configured"?

A.    The first thing to find out is how much disk space you are donating for a swap file. Opening the 
Control Panel, 386 Enhanced Mode applet and pressing "Virtual Memory", will display the amount. It is 
better to dedicate a "permanent" swap file if you can manage it. For a machine containing 4 Megs of 
RAM, an 8 Meg swap file would be ideal. The Program Manager Help/About box should display over 9 
Megs of virtual memory in this case (with no other apps loaded). 
Other things to check for are TSRs such as RAM drives: Disable them. These are of no use on a 
Windows machine with less than 16 megs of memory. Look in the AUTOEXEC.BAT (or CONFIG.SYS for
older DOS), for the amount of RAM being given to SMARTDRV. With a 4 Meg machine, SMARTDRV 
should be configured to use 512K of memory when running Windows. (This is the default on a 4 meg 
machine). This may cause more disk accesses and slow things down slightly, but you can play all the 
GIFs here!    Obviously the best solution is to get more memory. And yes, we own stock in a chip factory.



I don't have a sound card or any other MIDI device. Can I still see the images?
MM:GIF must have a MIDI device to "talk" to in order to play mmgifs. However, you can obtain MPCable
(mpc.zip) from the Sight and Sound Forum and install it on your machine. MPCable is designed to be a 
patch cable between MIDI devices, but it does not need to have both ends plugged in. You can select it 
in your MIDI Configure Dialog and MM:GIF will send its MIDI information to the cable. The MIDI data will
spray out of the other end of the cable and eventually fill up the inside of your computer. To remove 
those bytes, we sell a device called MIDI Vacuum . . .Just Kidding, folks. The MIDI data will harmlessly 
"evaporate".






